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Acerca del Manual  

Este manual permite utilizar de manera segura y eficiente los 

detectores de gas (en adelante, "GDA" o "dispositivo"). El 

manual es un componente del GDA y debe guardarse en las 

junto con el dispositivo, donde sea accesible para el personal 

en todo momento. 

El personal debe haber leído este manual en detalle y 

comprenderlo antes de utilizar el equipo. El cumplimiento de 

la información de seguridad y las instrucciones de este 

manual es un requisito previo para trabajar con seguridad. 

Además, se tendrán que aplicar las normas locales de 

seguridad y salud ocupacional y las normas generales de 

seguridad para el área en la que se utiliza el GDA 

Las ilustraciones de este manual están destinadas a 

proporcionar una comprensión general y pueden desviarse 

del diseño real. 

 Otros documentos aplicables  

Los documentos del apéndice también se tienen que leer, 

adicionalmente al manual. Cumpla siempre con la 

información incluida en el apéndice, en particular la 

información de seguridad. 
   

 Derechos de autor 

El contenido de este manual está protegido por derechos de 

autor. El contenido se puede utilizar en el contexto del uso del 

dispositivo. No se permite ningún otro uso sin la aprobación por 

escrito de AIRSENSE Analytics GmbH. 

 Condicones de Garantía 

Las condiciones de garantía se pueden encontrar en los Términos 

y condiciones generales de AIRSENSE Analytics GmbH.. 

 Fábrica/Servicio 
 

Dirección AIRSENSE Analytics GmbH 

Hagenower Str. 73 

19061 Schwerin, Germany 

Teléfono. + 49 (0) 385 3993 280 

Fax + 49 (0) 385 3993 281 

E-mail info@airsense.com 

Internet www.airsense.com 
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1 Vista general del Gas Detector Array (GDA) 

1.1 Guía de inicio rápido 

 

 

El GDA es un instrumento de medición portátil. Detecta 

gases y agentes químicos, y emite una alerta si hay algún 

riesgo.  

Se basa en una tecnología de sensor híbrido. Esto signi-

fica que tiene entre 4 y 5 sensores diferentes para la de-

tección de gases y materiales disponibles. Las sustancias 

detectadas presentan un patrón el cual es registrado por 

los sensores. Si el patrón grabado correspondiente a una 

sustancia detectada coincide con un patrón de la biblio-

teca del GDA, entonces la sustancia detectada puede ser 

identificada y cuantificada. Las librerías estándar de la 

GDA se pueden ampliar con otras librerías. 

 

1.2 Recambios y partes 

1.2.1 Partes 

  

Ilustración Descripción Número de 

parte 

Gas Detector Array 

 

Unidad de alimentación, cable de alimentación y RS-

232 

Entrada: 100 – 240 V, 1.3 A max., 47 – 63 Hz 

Salida: +11 – 13 VDC/4.2 A (ROJO) 

Potencia: 50 W max.; RS 232 serie 

 

101299 

110191 

100598 

 

 

Unidad de alimentación para la batería 

incluye el cable principal 

 

Celda de Litio, Entrada: 100 – 240 VAC 

50 – 60 Hz, max. 0.9 A 

Type 9940, luz de control 

 

100245 

100503 
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Ilustración Descripción Número de 

parte 

 

Estación de carga 

 

Potencia de entrada: 16.8 V – 2 A 

 

100234 

 

Batería de Litio 

 

14 V/4.5 A 

Recargable 

 

100233 

 

Maletín de transporte 

 

Dimensiones (approx.): L 46.5 cm x B 26.5 cm x A 31 cm 

 

400108 

 

Desorbedor térmico 

 

Lámpara: 12 V/20 watt 

Tiempo de operación: ca. 2,000 h 

Diametro: 35 mm/30° flood 

400050 

 

Herramienta para la comprobación del sistema  

(también llama módulo de calibración) 

400132 

 

Correa 

 

Longitud: approx. 140 cm 

Color: black or camel 

 

410069 

 

Pinzas perforadas 

 

100471 
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Ilustración Descripción Número de 

parte 

 

Kit de sellado 

 

 4 piezas 3x1  2 piezas 8x1.6 

 4 piezas 12x1.5  3 piezas 16x1.5 

 1 pieza 15x1  1 pieza 22x1   

 1 pieza 18x1.5 

 

400056 

 

Destronillador 

 

Torx T8 x 60, antiestática 

 

100366 

 

Adaptador de puerto USB 

 

Conexión RS 232 – USB 

 

100553 

 

WinMuster GDA software CD 

incl. USB Manual de Drivers 

 

For Windows 2000, NT, XP, 7  

 

502031 

 

Unidad de filtración externa 

 

Material de gel de sílice y carbon activo 

400059 

Soporte para la unidad de filtración externa 

 

100712 

Fuente de alimentación para la unidad de filtración 

externa 

 

Adaptador AC/DC 

PRI: 230 V ~, 50 Hz, 23.7 W 

SEC: 12 V –, 1000 mA, 12 VA 

 

100582 

 

Filtro de partículas 

 

PTFE 0.45 µm 

 

100147 
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Ilustración Descripción Número de 

parte 

 

Celda Electroquímica 

 

Monitox Plus/Sositox sensor COCL 2 

0 a 1 ppm 

 

100398 

 

Filtro Zero-air 

 

Filtro de acero inoxidable 

Reciclable por AIRSENSE 

Material: carbón activo 
 

400532 

 

Filtro circulatorio 

 

Filtro de acero inoxidable 

Reciclable por AIRSENSE 
 

400533 

 

Sustancia de comprobación 

(también llamada gas de test) 

1,1,1-tricloroetano 

CAS no. 71 – 55 – 6 

400066 
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1.2.2 Accesorios y recambios 

Ilustración Descripción Número de 

parte 

 

Lámpara PID 

 

Lámpara UV, 10.6 eV 

 

100397 

 

Pieza de entrada de gas de muestra 

 

Con cubierta metálica 

 

100419 

 

Dopante químico con base de amoniaco 

 

Ver hoja de seguridad del fabricante 

100463 

 
 

Carbón activo 

 

Material para rellenar la unidad de filtrado externa 

500023 

 

 
 

 

Gel de sílice 

 

Gel de sílice con indicador de humedad (gel naranja) 

Material para rellenar la unidad de filtrado externa 

 

Amarillo/naranja = nuevo 

Blanco = consumido  

 

500026 
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2 Seguridad 
 

 Esta sección proporciona una visión general de todos los as-

pectos de la seguridad para la protección de las personas, 

así como para el funcionamiento seguro y sin problemas. 

 

2.1 Explicación de los símbolos 

Nota de seguridad La información de seguridad se encuentra marcadas con sím-

bolos en este manual. Las precauciones son iniciadas por las 

palabras de advertencia, que expresan la magnitud del riesgo. 
 

 

¡PELIGRO! 

Esta combinación de símbolo y palabra de adver-

tencia indican una situación de peligro inmediato 

de muerte o lesiones graves, si no se evita. 
  

 

¡ADVERTENCIA! 

Esta combinación de símbolo y palabra de adver-

tencia indican una situación potencialmente peli-

grosa que puede provocar la muerte o lesiones 

graves, si no se evita. 
 

 

 

 

¡PRECAUCIÓN! 

Esta combinación de símbolo y palabra de adver-

tencia indican una situación potencialmente peli-

grosa que puede provocar lesiones leves o mode-

radas, si no se evita. 
  

 

 

 

¡ATENCIÓN! 

Esta combinación de símbolo y palabra de adver-

tencia indican una situación potencialmente peli-

grosa que puede provocar daños materiales o del 

medio ambiente, si no se evita. 
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Consejos y recomendaciones 
 Este símbolo resalta consejos útiles, recomendaciones e 

información útil para un funcionamiento eficiente y sin 

problemas. 

 

  

Otras marcas Los siguientes símbolos se utilizan en este manual para resaltar 

instrucciones, resultados, listas, referencias y otros elementos: 
 

➢ Instrucción individual 

1., 2., 3. etc. Instrucciones paso a paso 

 Resultados de los pasos de acción 

● Listados sin una secuencia específica 

“DISPLAY” Elementos de la pantalla, menú, etc. 
 

 
 

2.2 Uso previsto 

 El GDA es de uso exclusivo para detección de gases y agen-

tes de guerra en atmósferas no explosivas. 
 

 

 

 

 

 

 

 

 

 

 

 

Cualquier uso fuera del previsto es considerado un mal uso del 

equipo. 
 

 

¡ADVERTENCIA! 

¡Peligros debido al mal uso! 

Un mal uso del equipo puede ocasionar situaciones 

peligrosas: 

– Nunca permita que líquidos o humos penetren el 

dispositivo. 

– Nunca utilice el GDA en atmósferas potencial-

mente explosivas. 

– Asegúrese que el GDA se encuentra descontami-

nado y listo para operar antes de su uso. 
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2.3 Peligros Importantes 

Corriente eléctrica 

 

Fig. 1: Símbolo de peligro en la eti-

queta de características 

 

 

 
ADEVERTENCIA! 

¡Peligro de muerte por corriente eléctrica! 

El dispositivo funciona con corriente eléc-

trica. El daño en el aislamiento o los com-

ponentes eléctricos dañados son poten-

cialmente mortales 

– nunca abra el equipo. 

– Si el aislamiento está dañado, desco-

necte inmediatamente la fuente de ali-

mentación y avise a servicio técnico 

– Mantenga la humedad alejada de las 

partes activas. La humedad puede pro-

vocar cortocircuitos 

– Desconecte el dispositivo de la fuente de 

alimentación y retire la batería antes de 

reparar y limpiar el dispositivo. 
 

 

 

Fuente Radioactiva 

 

Fig. 2: Símbolo de peligro en la eti-

queta de características  

 

 
ADVERTENICA! 

Peligro fuente de radiación radiactiva! 

El GDA contiene una fuente de radiación 

radiactiva encapsulada de forma múltiple 

(fuente Ni63). La radiación emitida por la 

fuente de radiación radiactiva tiene un 

rango de solo 2-3 cm, lo que significa que 

el usuario no está expuesto a ninguna ra-

diación si el dispositivo se usa como está 

previsto. Sin embargo, es importante 

cumplir con los principios básicos para 

dispositivos con fuentes de radiación ra-

diactiva. 

– nunca abra el dispositivo 

– Utilize solamente el dispositivo para las 

activades prevista en este manual.  

– Si el dispositivo se ha caído, se ha vol-

cado y/o muestra signos externos de 

daño, no lo utilice y envíelo a AIRSENSE 

Analytics GmbH para su revisión / repa-

ración. 
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Líquido o humos en el dispositivo 
 

 
ATENCIÓN! 

Daño en el dispositivo! 

Si entran líquidos o vapores en el dispositivo, 

el dispositivo se dañará inevitablemente. 

–  Nunca aspire líquidos o humos en el disposi-

tivo.  
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2.4 Requisitos del personal  

 Las diversas tareas descritas en este manual presentan diferen-

tes requisitos para la cualificación de las personas encargadas 

de estas tareas. 

 

 

ADVERTENCIA! 

Peligro por calificación insuficiente 

del personal NG! 

Las personas insuficientemente cualificadas no 

pueden evaluar los riesgos que implica la manipu-

lación del dispositivo y se exponen a sí mismos y a 

los demás al riesgo de sufrir lesiones graves o mor-

tales. 

– Solo permita que personas debidamente califica-

das realicen el trabajo. 

  
 

  Solo las personas de las que se puede esperar que realicen el 

trabajo de forma fiable están autorizadas a realizar el trabajo. 

Personas cuya capacidad de reacción se vea afectada, p. Ej. de-

bido a drogas, alcohol o medicamentos, no se les debe permitir 

trabajar con el dispositivo. 
 

  Este manual especifica las siguientes calificaciones para las per-

sonas que realizan las diversas tareas: 
 

Usuario El usuario utiliza el sistemna GDA para su uso previsto. El per-

sonal de AIRSENSE Analytics o su distribuidor autorizado ha 

formado específicamente al usuario básico sobre cómo utilizar 

el dispositivo. El usuario también ha sido capacitado por el ex-

perto y sabe qué tareas hacer. Este usuario puede realizar de 

forma independiente las tareas que le han sido asignadas y evi-

tar posibles peligros.  
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Experto El experto está familiarizado con las sustancias químicas gra-

cias a su formación y educación. Además, este usuario ha sido 

formado en detalle por el personal de AIRSENSE Analytics o su 

distrubuidor en las funciones y el software del equipo. 

Por lo tanto, el experto está íntimamente familiarizado con el 

GDA y su software. 

Este usuario puede realizar todas las opciones del dispositivo y 

software. Incluyendo tareas complejas como formatear la tar-

jeta SD o restaurar los datos de la tarjeta SD. 

El experto realiza tareas dentro del ámbito del nivel de usuario 

avanzado "ADMIN". Sin embargo, esto es independiente del 

área de tareas del grupo objetivo "administrador-istrador (TI)" 

(ver más abajo). 

 

Supervisor del equipo El supervisor del dispositivo ha sido capacitado específica-

mente por el personal de AIRSENSE Analytics o su distribuidor 

autorizado en el mantenimiento y la resolución de problemas 

del dispositivo. Por lo tanto, el supervisor del dispositivo puede 

realizar de forma independiente las tareas que se le asignan. 

 

Administrador (IT) El administrador (IT) es un miembro del departamento de IT de 

la institución en la que se utiliza el GDA. El administrador (IT) 

es responsable de instalar el software.. 

 

Personal de Servicio:   

AIRSENSE Analytics GmbH 

Algunas tareas solo pueden ser realizadas por AIRSENSE Analy-

tics GmbH. Ningún otro personal está autorizado para realizar 

estas tareas. 

Si las tareas que se indican en este manual como responsabili-

dad del “personal de servicio de AIRSENSE Analytics GmbH” 

son necesarias, comuníquese con nuestro departamento de 

servicio, consulte la página 3. 

 

Equipo de descontaminación Gracias a su formación, el equipo de descontaminación es ca-

paz de descontaminar adecuadamente dispositivos, trajes de 

protección y otros objetos contaminados, y es capaz de evitar 

posibles peligros 
 

  
  



 

AIRSENSE Analytics GmbH 

Hagenower Strasse 73 · Germany 19061 Schwerin · Phone +49 (0) 385 3993280 · Fax +49 (0) 385 3993281 · Email: info@airsense.com · www.airsense.com 

19 

2.5 Protección Medioambiental  

 

 
 

 
ATENCIÓN! 

¡Peligro para el medio ambiente por mani-

pulación incorrecta de sustancias peligrosas 

para el medio ambiente! 

La manipulación incorrecta de sustancias peli-

grosas para el medio ambiente, en particular 

la elimanción incorrecta de las mismas, 

puede dañar el medio ambiente+. 

– Cumpla siempre con la información que se 

especifica a continuación cuando manipule y 

deseche sustancias peligrosas para el medio 

ambiente. 

  
  

 Se utilizan las siguientes sustancias peligrosas para el me-

dio ambiente: 

Sustancia test:  

1,1,1-trichloroethane 

No vierta los desechos de la sustancia por el desagüe ni los 

arroje a la basura. En su lugar, coloque los desechos de la 

sustancia en recipientes recolectores de disolventes orgáni-

cos halogenados y disoluciones de sustancias orgánicas ha-

logenadas. Transfiera los recipientes recolectores al centro 

de reciclaje responsable o al centro de eliminación de resi-

duos. 

Dopante (ammonia) La hoja de datos de seguridad correspondiente describe 

cómo desechar el dopante. 

Baterías Las baterías contienen metales pesados tóxicos. Las baterías 

no deben desecharse con la basura doméstica. Deben elimi-

narse como residuos especiales y deben llevarse a los pun-

tos de recogida municipales o ser eliminados por una em-

presa especializada. 

Fuente radioactiva La vida media de la fuente radiactiva es de 100,1 años. La 

fuente radiactiva debe eliminarse correctamente. Una vez 

que el sistema GDA llegue al final de su vida útil, envíenoslo 

de regreso (consulte la página 3 para obtener la dirección 

del servicio) 

Componentes electrónicos y lám-

paras 

Los componentes electrónicos y las lámparas deben 

desecharse como residuos especiales y deben llevarse a 

puntos de recogida municipal o ser eliminados por una em-

presa especializada.  
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3 Descripción 

3.1 Vista general 

  

 

Fig. 3: Vista frontal y lateral del GDA (lado derecho) 

 

1 Botones   6 Entrada del gas (con tapón) 

2 Pantalla   7 Clip de cierre 

3 LED para alarma visual   8 Bocina para alarma acústica  

4 Anilla para colgar de la correa  9 Antena Wireless (opcional) 

5 Trampilla de servicio  10 Antena GPS (opcional) 
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Fig. 4: Vista trasera y lateral del GDA (lado izquierdo) 

 

1 Anilla para colgar de la correa  7 Filtro de Aire cero 

2 Botón de apagado  8 Gas de salida (con tapón) 

3 Interfaz RS-232   9 Filtro de Circulación 

4 Batería  10 Pin para el tapón del gas de salida 

5 Pin para la tapa de entrada de Aire cero  11 Entrada para el Dopante 

6 Entrada de Aire cero (con tapa de protec-

ción) 

 12 Pin para el tapón del gas de entrada 
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3.2 Flujo de gas y sistema de dilución 

 

El aire ambiental a analizar es aspirado a través de la entrada de gas. Si la concentración de los ga-

ses aspirados muy alta, el GDA puede contaminarse rápidamente. Por lo tanto, el gas aspirado se 

diluye con aire ambiente filtrado previamente. La dilución se realiza de forma automática cuando 

el GDA es operado en modo automático, aunque también se puede ajustar manualmemnte. Este 

monitorizaje augmeta la vida útil de los sensores. 

Modo de purga 

 

 Aire contaminado 

 Aire altamente diluido 

 Sensor de flujo 

 Bomba 

 Válvula 

A Entrada de gas 

B Salida de gas 

C Entrada de aire cero 

1 Sensores 
 

 

 

El modo de purga es una función de protección automá-

tica del GDA para evitar la contaminación de los senso-

res. Si detecta gases en alta concentración durante una 

medición, el GDA volverá automáticamente al modo de 

purga. Es posible que pasen varios segundos antes de 

llegar a niveles aceptables para la medición y estar dis-

ponible de nuevo. 

Si trazas de sustancias gaseosas permanecen en el sis-

tema, las mismas pueden afectar a la sensibilidad de la 

medición y a la detección de una sustancia 
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Modo de medición 

 

 Aire contaminado  

 Aire altamente diluido  

 Sensor de flujo  

 Bomba  

 Válvula  

A Entrada de gas  

B Salida de gas  

C Entrada de aire cero  

1 Sensores  
 

 

En el modo de medición, los cuatro sensores (espectró-

metro de movilidad iónica, detector de fotoionización, 

sensores de óxido metálico y la celda electroquímica) se 

incluyen en la evaluación. El modo de medición puede 

ser modificado y ajustado según los gases involucrados 

en la medición y el objetivo de la medición. 

 

Función de autoprotección del GDA 

El GDA continene un sistema de dilución que detecta de forma automática altas concentraciones 

de gases en la entrada de gas y purga con aire descontaminado para contrarrestar y autoprote-

gerse. Este sistema protege los sensores de concentraciones excesivas de gas que implica un me-

nor tiempo de puesta a punto para la siguiente medición. Adicionalmente, augmenta la vida útil 

de los sensores. 

Este sistema de autoproteción se implementa en forma de dilución automática. 
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 BACK 

 APPLICATION 

 SYSTEM CHECK 

  OPTIONS 

 

 DATA LOGGER 
 BACK 

 ALARM 

  AUTO DILUCIÓN 

 WIRELESS 

Diluciones En el modo manual, puede interrumpir la dilución automa-

tic pulsando el botón izquiero y, posteriomente, configurar 

una dilución diferente. 

Puede seleccionar los siguientes factores de dilución: 

Etapa de dilución Muestra % Aire % 

SP – Modo de purga 0 100 

98 – Dilución máxima 1 – 2 99 – 98 

95 – Dilución alta 3 – 5 97 – 95 

90 – Dilución media 6 – 10 94 – 90 

80 – Dilución media-baja 11 – 20 89 – 80 

50 – Dilución baja 21 – 50 79 – 50 

 0 – Dilución mínima 51 – 100  49 – 0  

   
 

 Si durante la medición a una dilución determinada, el dis-

positivo detecta una respuesta superior al límite especifica-

doen alguno de los canales, el GDA regresa al modo de 

purga, donde se limpia. Unos segundos mas tarde, el dispo-

tivo vuelve gradualmente al modo original de medición (o 

al correspondiente estado de dilución. 

 
 The application selected on starting or in the main 

menú starts automatically with a predefined dilución stage, 

e.g. the warfare agent application starts at the highest sen-

sitivity, i.e. with the lowest dilución stage 0. 

Función de autoprección on/off 

(Dilución automática) 

 

Durante el modo normal de operación, el GDA vuleve auto-

máticamente al modo de purga. 

Esta función protégé los sensores de sobrecargas y asegura 

que el dispotivio permanece listo para trabajar de manera 

óptima incluso en condiciones adversas.  

 

Por otro lado, esta función puede impeder ligeramente ya 

que puede tomar unos segundos para regresar al modo de 

medición. 

Por esra razón, el usuario puede desactivar el modo de au-

toprotección si lo cree conveniente en: “OPTIONS”, “AUTO 

DILUCIÓN”. A menos que sea imprescindible, no se reco-

mienda desactivar esta opción.  
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3.3 Tipos de sensores y canales 

 

 El GDA está equipado con 4 tipos de sensores: 

● Espectrómetro de movilidad iónica (IMS) 

● Sensor de óxido metálico (MOS) 

● Celda electroquímica (ECC) 

● Detector de fotoionización (PID) 

 

Fig. 5: Pantalla de canales 

Los sensores se asignan a 8 canales. Cada canal responde a 

diferentes tipos de sustancias. La respuesta en cada canal se 

aprecia de esta manera (Fig. 5). 
 

Canal Sensor Tipo de sustancia 

A IMS Principalmente amoniaco 

B IMS Compuestos halogenados, cianuros y  

ácidos 

C IMS Sustancias orgánicas y agentes quími- 

cos de guerra 

D IMS Sustancias organicas, ácidos, agentes  

químicos de Guerra, TDI y fenoles. 

E, F MOS Banda ancha, gases oxidables y  

alcoholes  

G ECC Ácidos, fosfina, arsénico, fosgeno, H2S 

H PID Aromáticos, hidrocarburos no saturados 
   

 

Sensores y sustancias 

 

La selectividad y la sensibilidad de los sensores permiten una 

amplia banda de detección de sustancias. Todos los sensores 

se utilizan simultáneamente para la detección e identifica-

ción. 

 

Ejemplo de sustancias almacena-

das 

Como ejemplo, algunas sustancias que pueden ser detecta-

das e identificadas se enumeran a continuación.  
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Código de color 
En la tabla se asigna un color para ayudar a ilustrar cada 

sensor. La intensidad del color indica lo bien que      una sus-

tancia puede ser detectada. A mayor oscuridad, más fácil-

mente se detectará la sustancia. 

 

  
 

Sustancia ETW [ppm] IMS PID ECC MOS 

Ácido acético 20     

Acetona 500     

Acroleïna 0.2     

Acrilonitrilo 20     

Amonio 50     

Benzeno (B/T/X) 20     

Dióxido de carbono 10000     

Monóxido de carbono 100     

Cloro 1     

Clorobenceno 100     

Cianuro 0.3     

Etanol 3000     

Formaldehído 1     

n-Hexano 200     

Hidrazina 1     

Fluoruro de hidrógeno 5     

Metanol 500     

Dióxido de nitrógeno 1     

Fosgeno 0.1     

Fosfina 0.5     

Estireno 40     

Dióxido de azufre 1     

Sulfuro de hidrógreno 10     

Tetracloroetileno 100     

Tolueno 100     

Tolueno di-isocianáto, TDI 0.02     

1,1,1-Tricloroetano 300     

1,1,2-Tricloroetano 25     

Tricloroetileno 100     

Cloruro de vinilo 100     
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Agentes de guerra Además de la detección de gases tóxicos, el GDA detecta 

los siguientes agentes de guerra: 
  

Nervioso Piel Sangre 

Tabún Gas mostaza AC 

Sarín Mostaza nigrogenada Cyclon B 

Somán Lewisita — 

Ciclosarín — — 

VX — — 
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3.4 Visualización de la información 

 

 

 

 

Cuando la medición con el GDA ha comienza, la mezcla 

de gases que va a ser analizada se compara continua-

mente con los patrones almacenados en la biblioteca. 

Como resultado, el GDA comunica sus valores dinámi-

camente en 3 formas diferentes para el usuario:  

● Pantalla 

● LED para la alarma visual 

● Bocina para la alarma acústica 

 

Pantalla 

Fig. 6: Pantalla de canales 

 

 

 

Fig. 7: Pantalla de sustancia (con una 

sustancia detectada y su respectiva 

concentración) 

El usuario puede observar el estado de los diversos sen-

sores en la pantalla. 

El resultado se muestra de dos formas, que se alternan 

cada 2 segundos: 

● Pantalla de canales (8 canales, con una barra cada 

uno, Fig. 6) 

● Descripción y concentración de la sustancia detec-

tada 

El resultado de la detección se muestra en pantalla si la 

pauta coincide con una alta precisión con alguna alma-

cenada en la biblioteca. Se pueden mostrar hasta dos 

posibles sustancias. 

Si no hay entradas en la librería para la sustancia anali-

zada, la pantalla de canales proporcionará información 

sobre los grupos funcionales presentes en la sustancia. 

Adicionalmente, el software puede ser utilizado para 

obtener información mas amplia (valores de K0 del IMS, 

por ejemplo). 
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Alarma acústica y óptica 

 

El GDA tiene un LED para emitir una alarma visual y una 

bocina para proporcionar alarma acústica para alertar al 

usuario de gases tóxicos.  

LED 

 

Fig. 8: Alarma óptica  

 

El LED puedeparpadear en 3 frecuencias diferentes, que 

indican:  

 

● Frecuencia más lenta: El GDA está operativo, listo y 

se encuentra en modo de espera/purga. No hay 

alarma. 

● Frecuencia media: La GDA ha alcanzado un umbral 

de concentración, pero sin identificar la sustancia 

presente. Esta es una alarma. 

● Frecuencia más alta: El GDA ha detectado una sus-

tancia cuya concentración está por encima del um-

bral almacenado en la base de datos. Esta es una 

alarma. 

Bocina 

 
Fig. 9: Alarma acústica 

La bocina puede emitir tonos en 2 frecuencias diferen-

tes, que indican:  

 

● Frecuencia lenta: La GDA ha alcanzado un umbral 

de concentración, pero sin identificar la sustancia 

presente. Esta es una alarma. 

 

● Frecuencia alta: El GDA ha detectado una sustancia 

cuya concentración está por encima del umbral al-

macenado en la base de datos. Esta es una alarma. 

 

LED y bocina dan su información simultáneamente para 

que el usuario, en caso de alarma, pueda ser advertido 

de manera eficaz y urgente sin tener en cuenta el ruido 

ambiente, la audición, visibilidad o la visión directa del 

dispositivo. 

 

 La alarma sonora se puede desactivar, según sea 

necesario, consulte "alarma sonora".  

Dado que esto afecta la atención del usuario, se in-

forma de ello cuando la unidad se pone en marcha. 

Se recomienda tener la alarma acústica siempre ac-

tivada. 
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3.5 Aplicaciones y métodos de análisis 

 

Al operar el GDA, un usuario puede enfrentarse a situaciones muy diferentes. El gas de muestra 

puede estar presente en concentraciones muy pequeñas o puede estar muy contaminado. No 

siempre está claro qué concentración de gases tendremos en la muestra. La muestra puede con-

tener gases muy volátiles o puede contener componentes que son muy difíciles de medir y solo 

liberan pequeñas cantidades de gas. 

 

Por lo tanto, el sistema GDA ofrece una variedad de aplicaciones y métodos de muestreo. Las bi-

bliotecas especiales, los parámetros de medición y los métodos de muestreo se pueden ajustar y 

agrupar en una aplicación. Diferentes herramientas o estrategias de muestreo ayudan a optimizar 

la aplicación a los gases de muestra en cuestión. 

Una única aplicación implica diferentes combinaciones de configuraciones especiales dentro del 

dispositivo:  

a) Librería 

b) Método a utilizar 

c) Temperaturas del equipo  

d) Ionización: Con o sin dopante  

Las aplicaciones más importantes y sus configuraciones se describen a continuación. Las solucio-

nes específicas del cliente pueden diferir de estas configuraciones (consulte la documentación se-

parada). 
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3.6 GDA First Response start menú  

 

Pantalla de inicio del equipo: 

  APPLICATIONS 

▶ A: STANDARD 

  

B:  

C:  

D: CWA (NH3) 

E: PID 

RADIOACTIVE (optional) 

  
Fig. 10: Vista general del menú de inicio 

   

      

READY    

     

START MENÚ   

Modo de medición estándar (A) 
El modo de medición estándar es de aplicación específica y se 

muestra automáticamente al iniciar la medición. 

Normalmente, la plaicación A es el modo de medición es-

tándar. This affects the library and the temperature and 

flow control.  

 

Dilución: El modo de medición estándar comienza con una 

dilución al 90% (se muestra como 90 en pantalla). 

El GDA permanece en esta dilución durante 30 segundos. 

Posteriormente, el GDA reduce la dilución gradualemente, 

paso a paso, hasta que obtiene señal. Ya que el dispositivo 

reacciona a la medición en tiempo real, la dilución puede 

llegar a reducirse al 0% (valor mínimo) en este modo. La di-

lución gradual require que el modo de dilución automática 

esté activo.  

Librería: Se utiliza la librería estándar (agentes toxicos in-

dustriales (TIC) y de guerra (CWA) se miden simultáea-

mente). 

Química: química del agua (no se usa dopante) 

Modos B y C  Los modos B y C son modos de medición estándar, pero 

usan diferentes librerías, de modo que diferentes sustancias 

puedan ser medicións. 
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Modo específico para agentes de 

guerra (química del agua) 

Si el modo “CWA” es seleccionado, el GDa comienda con la 

mayor sensibilidad posible a las sustancias (0% de dilución). 

Dilución: 0% dilución   

Requiere tener activa la dilución automática. 

Librería: base de datos de agentes de guerra (CWA) 

Química: química del agua (no se usa dopante) 

Modo específico para agentes de 

guerra (química del amoniaco, D)  

La medición puede ser utilizada para hacer un análisis pre-

cioso del gas a ser detectado. Es un modo de uso del GDA 

avanzado. Si, después de una medición estándar, se sopecha 

de algún agente de guerra, la química del amoniaco puede 

ser utilizada para analizar con precision el gas. Seleccione el 

modo “CWA (NH3)”. 

Se recomienda utilizar recambios originales del fabicante 

Dilución: 0% dilución   

Requiere tener activa la dilución automática. 

Librería: base de datos de agentes de guerra (CWA - NH3) 

Química: química del amoniaco (requiere dopante) 

Modo E: PID El detector de fotoionización se utiliza para cuantificar sus-

tancias aromáticas que ya han sido identificadas. 

En esta aplicación, debe seleccionar la sustancia de la libre-

ría. El factor de respuesta se selecciona de la librería están-

dar, como por ejemplo acetona.  

Dilución: 95% dilución   

Librería: Se utiliza la librería estándar  

Química: química del agua (no se usa dopante) 
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Verificación de contaminación su-

perficial (KNG) 

Gracias a la sensibilidad de detección de incluso la versión 

básica, el GDA es adecuado para la verificación puntual de 

trajes y vehículos de protección contaminados. Para aumen-

tar la sensibilidad de detección, que es necesaria para una 

contaminación menor o después de la descontaminación, 

las superficies se pueden calentar ligeramente y probar con 

un termodesorbedor especial que se monta sobre la en-

trada de gas GDA. 

El modo de medición para verificar superficies contamina-

das puede detectar e identificar sustancias en cantidades 

mínimas (p. Ej., Una mancha o spray de una sustancia des-

conocida, superficies de ropa o materiales y objetos des-

pués del despliegue de una sustancia peligrosa). 

También es posible comprobar si la descontaminación se 

realizó correctamente o si es necesario repetirla. Además, 

este modo se puede utilizar para mejorar la verificación de 

sustancias altamente volátiles. 

Puede cambiar al modo para medir superficies con el termo-

desorbedor en muchas aplicaciones a través de la opción del 

menú principal "Opciones / medición KNG" (consulte el ca-

pítulo "4.4.3.1 Examinar superficies en busca de contamina-

ción (medición KNG)" en la página 43) . 
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4 Midiendo con el GDA 

4.1 Instrucciones de seguridad para la medición 

 

 
 

 
ATENCIÓN! 

Daños al dispositivo! 

Si líquidos o humos penetran el dispositivo, 

este se dañará inevitablemente. 

–  NUNCA succione líquidos o humos. 

  
 

 
 

4.1.1 Menú de navegación 

 

 

Fig. 11: Botones para el menú de na-

vegación 

Puede navegar por el menú con la ayuda de dos boto-

nes.  

El botón de la izquierdo (Fig. 11/1) realiza las siguientes 

acciones:  

● Navegación en el menú 

● Selección de la dilución en el modo de medición 
 

The right-hand push-button (Fig. 11/2) performs the 

following functions: 

● Acceder al menú 

● Confirmar su selección 

● Confirmar el modo de purga 
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4.2 Vista general del menú del GDA-FR  

 

1er nivel   2ndo nivel  3er nivel 

MENÚ PRINCIPAL GDA    

BACK  BACK   

  A: STANDARD   

APPLICATION  B:    

  C:   

  D: CWA (NH3)   

  E: PID   

     

  BACK   

  FUNCTION TEST   

SYSTEM CHECK  PEAK HEIGHTS   

  TEMPERATURES   

  ENERGY STATUS   

  INFO   

     

  BACK  BACK 

  ALARM  ACOUSTIC 

OPTIONS  AUTO DILUCIÓN  VISUAL 

  WIRELESS  TEST 

  KNG MEASUREMENT  DISPLAY LOG 

  ADMIN LEVEL   
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4.3 Encendido y apagado del GDA (on/off) 

 

Encendido del GDA 1. Retire las tapas protectoras de la entrada y salida de 

gas y la entrada de aire cero. 

 

Fig. 12: Compartimento de las bate-

rías 

2. Conecte a la fuente de corriente.  

Para ello, puede: 

– Afloje el tornillo del compartimento de la bate-

ría (Fig. 12) y abra la trampilla. 

– Inserte la batería. 

– Cierre la tapa y apriete el tornillo de nuevo. 

 

 

Fig. 13: Tapa de protección para el 

cable RS-232 

O bien: 

 Asegúrese que la batería no está conectada (vea el 

apartado anterior). 

 Quite la tapa girando en sentido anti-horario 

(Fig. 13/1). 

 Conecte el cable RS-232. 

 No puede cargar la batería en el dispositivo. Si el dis-

positvo está conectado directamente a la corriente 

mientras la batería esta puesta, la batería no ejecuta 

ninguna función.  

 

 

Fig. 14: Botón de encidido/apagado 

(on/off) 

3. Pulse el botón de encendido una vez (Fig. 14/1). 

 El GDA se enciende y comienza a iniciarse. 

4. Si la unidad está equipada con una conexión Wi-Fi, le 

aparecerá un mensaje sobre el estado de la conexión 

inhalámbrica. Confirme pulsando “CONTINUE”. 

5. Si la alarma sonora está apagada, le aparecerá un 

mensaje de advertencia “WARNING: ACOUSTIC 

ALARM OFF!”. Confirme pulsando “CONTINUE”. 
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 Aparece este mensaje en pantalla. 

 

 Si aparece este mensaje, no se han quitado los 3 ta-

pones protectores.  

6. Retire las tapas protectoras, y pulse el botón dere-

cho. 

 

 El dispositivo empieza a calentarse. 

7. Espere hasta que finalice el calentamiento y aparezca 

el siguiente mensaje en la pantalla 

 Si no puede esperar a que se caliente el dispositivo 

porque es necesario realizar de inmediato una medi-

ción, el calentamiento puede ser omitido. Sin em-

bargo, el GDA no estará en las condiciones óptimas 

de funcionamiento y se pueden activar falsas alar-

mas. 

 

 Los detalles de los picos positivo y negativo se mues-

tran ahora en pantalla. Si la señal del pico es superior 

a 250, la unidad se inicia automáticamente. 

 

8. Espere hasta que el menú se inicie por completo. 

 

 El modo de purga si inicia automáticamente. 

 El LED de la alarma óptica da destellos rojos. 

 El GDA está listo para operar. 

Apagar el GDA (off)  

 

1. Pulse y mantenga el botón izquierdo para cambiar el 

GDA al modo de purga. 

2. Confirme con el botón derecho. 

 El dispositivo se está purgando. 

 

3. Deje el GDA purgandose hasta que los canales esten 

limpios (mínimo 15 minutos). 

4. Pulse el botón de on/off dos veces. 

 El GDA se apaga. 

 

 

GDA- FR 

IS 

INITIALISING 

WARM UP 

MB: 49.7    DR:35.5 

SKIP 

RI KO PEAK 

POS: 2.10 164 

NEG: 2.22 695 

SKIP 

FLUSHING MODE 

A 

X 

S 

P 

A  B 

C  D  

E  F 

G  H  

A 

X 

S 

P 

REMOVE 

CAPS 

 

CONTINUE 

READY 

 

START    MENÚ 
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4.4 Realizar la medición 

4.4.1 Antes de cada medición 

Prerequerimientos ● Tener el GDA encendido. 

● Las auto-comprobaciones internas se han llevado a 

cabo con éxito durante la inicialización del dispositivo 

mediante la selección de la aplicación. 

● Se ha alcanzado la temperatura de funcionamiento. 

 Una vez que seleccione un método de medición, el GDA 

está inmediatamente listo funcionar. 

➢ Seleccione un método. 

 Durante el proceso de la medición, puede ajustar la 

dilución manualmente. 

 

 

 

 Hasta cuatro librerías pueden guardarse en el dispo-

sitivo, pero solo se puede activar una a la vez.  

 

1. Abra el menú principal y seleccione “APPLICATION”. 

2. Seleccione una aplicación. 

 La aplicación seleccionada en ese momento 

está marcada por una barra de color negro. 

  

 

  

 

BACK 

APPLICATION 

SYSTEM CHECK 

OPTIONS 

 █ A STANDARD 

B  

C 

D CWA (NH3) 

E PID 

ZERO ADJUSTMENT 

IN 

PROGRESS 
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4.4.2 Cambio manual de la dilución en el modo estándar 

 

 You can change the dilución manually in the standard 

measuring mode. 

1. Pulse el botón izquierdo hasta que se seleccione la 

dilución deseada. 

2. Pulse el botón derecho para confirmer su selección. 

 Si no pulsa el botón derecho, el factor de dilución no 

se guarda. La dilución anterior aparecerá en pantalla. 

 En mezcla de gases, la dilución automática puede perju-

dicar la identificación de sustancias. En estos casos, es 

útil apagarlo. El proceso de identificación lleva más 

tiempo y, por lo tanto, puede ser más preciso.. 

Contaminación de dispositivo 
 

 

Advertencia! 

Peligro para la salud! 

La dilución automática es una función pro-

tectora que protege el dispositivo, y por lo 

tanto al personal, contra la contamina-

ción.. 

– Una vez completada la medición, vuelva 

a activar la dilución automática 

  
 

 

1. En el menú principal, abra pestaña OPTIONS. 

  Pong la barra negra en AUTO DILUCIÓN indica 

que la dilución automática está activada. 

2. Para cambiar a dilución automática, confirme AUTO 

DILUCIÓN con el pulsador de la derecha. 

 La dilución automática está desactivada 

 Cuando el dispositivo se apaga y se vuelve a encen-

der, la dilución automática se activa nuevamente 

 

 
 

... 

 AUTO DILUCIÓN 

WIRELESS 

KNG MEASUREMENT 

ADMIN LEVEL 
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4.4.2.1 Medición de superficies contaminadas (Medida KNG) 

 

 
 Solo es posible probar la contaminación de superfi-

cies (medición KNG) si la fuente de alimentación 

está conectada. Si la fuente de alimentación no está 

conectada, no ocurrirá nada. 

 

Fig. 15: Tapón de protección 

1. Abra el tapón de protección (Fig. 15/1) girándolo en 

sentido antihorario 

 

 

 

Fig. 16: RS-232 cable  

2. Conecte la fuente de alimentación (cable RS-232). 

 

 

 

 

Fig. 17:  Clips de bloqueo abiertos 

3. Suelte los clips de bloqueo. 

4. Retirar la trampilla de servicio. 
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Fig. 18: Termodesorbedor 

5. Sujete el termodesorbedor al GDA con los clips de 

bloqueo. 

 El termodesorbedor está conectado al GDA. 

 

6. Abra el menu principal y seleccione OPTIONS y pos-

teriormente KNG MEASUREMENT. 

 El método de medición seleccionado se indica 

mediante una barra negra.. 

7. Sostenga el termodesorbedor sobre las superficies 

que desea examinar en busca de contaminación. 

 

 

 

Fig. 19: Termodesorbedor durante la 

medición 

8. Para iniciar la medición, presione el botón derecho. 

 El termodesorbedor se enciende. La duración 

de iluminación predeterminada es de tres se-

gundos; la medición se lleva a cabo durante 

este tiempo de iluminación. 

9. Monitorizar las respuestas. 

10. Si hay respuestas fuertes, sostenga el dispositivo 

más lejos, y si las respuestas son menores, puede 

colocar el dispositivo directamente contra la super-

ficie.. 

 Si la señal es demasiado fuerte (por encima de los lí-

mites de exposición), el dispositivo cambia instantá-

neamente al modo de descarga y reduce la dilución 

con pasos hasta que la dilución se estabiliza en un 

nivel que corresponde a las señales. El dispositivo 

siempre reacciona al estado actual de la señal, es 

decir, si la señal desaparece, el dispositivo continúa 

reduciendo la dilución por etapas hasta llegar al 0% 

(valor mínimo). Si la señal aumenta, el dispositivo 

comienza a aumentar la dilución nuevamente. 

11. Antes de volver a desconectar el termodesorbedor 

del dispositivo cuando haya terminado de medir, 

deje que se enfríe. 

 

BACK 

APPLICATION 

SYSTEM CHECK  

   OPTIONS 

 

 

…. 

WIRELESS 

   KNG MEASUREMENT  

ADMIN LEVEL 
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4.4.2.2 Medición de agentes de guerra (CWA) 

 

Durante la medición, todos los gases absorbidos cuyos patrones se almacenan en una biblioteca 

del GDA se identifican.  

Sin embargo, es possible que sustancias menos peligrosas tengan comportamientos similares a 

agentes de guerra y no sea possible identificarlos sin ambigüedad mediante el método en base de 

agua que se utiliza en el IMS. Por esta razón, se utiliza amonio como agente dopante para una 

identificación fiable de agentes de guerra. En la química del amoniaco hay menos superposiciones 

entre las sustancias menos peligrosas y los agentes de guerra.  

Mediante la adición de amoniaco, aquellas sustancias cuya afinidad protónica sea menor que el 

amonio son enmmascaradas. El procedimiento es el siguiente: se dispara una alarma mostrando 

en pantalla un agente de guerra (CWA) y consecutivamente se hace una medición utilizando el 

dopante. 

 

Procedimiento La detección de agentes de guerra y su confirmación se 

lleva a cabo en el modo de CWA. 

Observe lo siguiente: 

 1. En primer lugar, se lleve a cabo una medición basada 

en la química del agua (agua como agente ionizante, 

A o CWA (H2O)). 

2. Si la identificación no es clara y hay buenas razones 

para sospechar la presencia de agentes de guerra, en-

tonces se debe realizar una medición en el modo CWA 

con amoníaco.  

 Realice una medición usando el amoniaco como ioni-

zante sólo cuando realmente sea sospechoso la pre-

sencia de agentes de guerra, porque después de usar 

amoníaco, el GDA deberá ser sometido a una lim-

pieza exhaustiva y no podrá ser utilizado de inme-

diato para medicións en base de agua. 

 Muchos productos químicos industriales sólo pueden 

medirse con la química en base de agua. 
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Realizar la medición con la química del amoniaco 
 

 
 Después de la medición con amoniaco, el disposi-

tivo debe ser descontaminado. La descontamina-

ción es lenta y costosa, ya que requiere de varios 

cambios de filtro. Realice mediciones con amoniaco 

sólo si se sospecha de agentes de guerra. 

Material ● Herramienta de servicio (llave tipo Allen) 

● Dopate de amoniaco 

 1.  Apague el dispositivo. 

 

Fig. 20: Tapón protector 

2. Retire el tapón protector de la puerta de servicio. 

 

 

Fig. 21: Dopante de amoniaco 

3. Quiebre el flasco del dopante por la mitad. 

 

Fig. 22: Inserción del dopante 

4. Retire el dopante químico de amoniaco utilizando 

las pinzas. 

5. Introduzca el dopante químicos en la abertura indi-

cada. 
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Performing a measurement 

6. Selle la abertura con el tapón protector. 

7. Reinicie el dispositivo. 

 La unidad realiza una comprobación de amo-

niaco en el sistema.  

8. Abra el menú principal y seleccione “APPLICATION”, 

seguido por “CWA (NH3). Confirme la pregunta. 

 Se carga una biblioteca especial. 

9. Espera hasta que el dispositivo muestre “READY” en 

pantalla. 

10. Realice una medición usando la maxima sensibilidad 

(dilución al 0%).  

11. Durante la medición de agentes de guerra (CWA), 

no se observa diferencia respecto el funciona-

miento normal. Sin embargo, muchas sustancias no 

se miden ya que se centra en los agentes de guerra. 

 
 Después de haber completado la medición, el GDA 

debe ser descontaminado: 

● Descontaminar el equipo externamente. 

 

● Descontaminar el interior del GDA. 

 
 Si quiere medir mediante química del agua a poste-

riori, quite el dopante. 

  

SWITCH 

TO 

CWA MODE? 

NO   YES 

 

 

 

A: STANDARD 

B:  

C:  

   D: CWA (NH3) 
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4.4.2.3 Cuantificación de sustancias (modo E – modo PID) 

 

 El detector de fotoionización se utiliza para cuantificar 

sustancias aromáticas que ya han sido identificadas.  

 

1. Abra el menú principal y seleccione “APPLICATION” 

y entonces medición “PID”. Aparece una selección 

de sustancias comunes detectadas por el PID. 

 

 

2. Confirme la sustancia deseada. 

 El GDA activa el modo purga. 

 

 Por ejemplo, puede seleccionar acetone como 

sustancia a analizar en el modo PID. 

 El factor de respuesta de cada sustancia se selec-

ciona de la librería estándar; en este caso, acetona. 

Para seleccionar una sustancia distinta, elija otra 

sustancia en la lista anterior. 

3. Para seleccionar una sustancia distinta oulse el bo-

tón derecho. 

 

 Se abre el menú del PID. 

4. Seleccione “SUBSTANCE LIST”. 

 Aparecerá una lista de sustancias. 

 

5.  Seleccione la sustancia a cuantificar. 

6. Confirme su selección con “SELECT”. 

 Si entonces selecciona “CONTINUE”, la sustancia se-

leccionada será cuantificada.  

 

 En pantalla se muestra el modo PID y la sustan-

cia seleccionada. 

 

 

7. Inicie la medición pulsando el boton izquierdo para 

seleccionar el factor de dilución. 

 Si no esta seguro que factor de dilución utilizar, 

pulse el botón derecho para seleccionar el modo de 

dilución automática. 

 
0 PPM 

ACETONE  

ETW: 500.0 PPM 

 A 

X 

S 
P 

BACK 

APPLICATION 

PID ONLY 

   SUBSTANCE LIST  

 

 

 

ACROLEIN 

AMMONIA 

BENZENE 

      CS2  

 

 

 

BENZENE 

RESPONSE: 0.53 

ETW: 20.0 PPM 

SELECT                     CONTINUE 

 

 

 
0 PPM 

BENZENE  

ETW:  20.0 PPM 

 A 

X 

S 
P 

A: STANDARD 

B:  

C:  

D: CWA (NH3) 

  E: PID 
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8. Confirme su selección del factor de dilución con el 

botón derecho. 

 

 El GDA inicia la medición y cálculo de la conce-

tración. La concetración se muestra en ppm 

(partes por millón). 

9. Para salir del modo PID, pulse el botón derecho. 

 Se abre el menú del PID. 

 

10. Seleccione “APPLICATION”. 

11. Confirme su selección. 

4.5 Después de completar la medición 

 

1. Ponga el GDA en modo purga manteniendo pulsando 

el botón izquierdo hasta que aparezca “SP” en panta-

lla y confirmando su selección con el botón derecho. 

 El sistema empiza a purgarse. 

 

2. Deje el GDA purgando hasta que todos los canales 

estén limpios (se recomiendan mínimo 15 minutos). 

El aparato realiza un ajuste a cero y muestra 

“READY” en pantalla cuando ha terminado. 

  

 

3. El GDA se apaga como se describió en el capítulo “4.3 

Encendido/apagado del GDA”  

a) Compruebe la unidad de purga: Si el gel de sílica 

es blanco, debe sustituirlo 

b) Abra la entrada y salida de gas 

c) Disconecte la unidad de purga  

d) Active la unidad de purga  

 

 
4.6.1    

 
0 PPM 

BENZENE  

ETW:  20.0 PPM 

 

 

 A 

X 

S 
P 

 

BACK 

     APPLICATION 

AUTO DILUCIÓN 

SUBSTANCE LIST 

 

 

       

 

 

FLUSHING DEVICE 

A 

X 

S 
P 

A  B 

C  D 

E  F 

G  H 

A 

X 

S 
P 
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4.6 Encender o apagar la alarma acústica 

 

 

1. Abra el menú principal y seleccione “OPTIONS” se-

guido por “ALARM”.  

 Si la barra de color negro está al lado de “AC-

COUSTIC”, la alarma se encuentra activa. 

2. Para apagar la alarma, seleccione “ACOUSTIC”.  

 La barra de color negro desaparece y la alarma 

acústica es desactivada. 

 

 

 

4.7 Comprobación de la alarma acústica 

 

 

1. Abra el menú principal y seleccione “ALARM”. 

2. Seleccione “TEST”. 

 La alarma se enciende. 

3. Para apagar la alarma, vuelva al menu principal. 

4. Seleccione “ALARM”. 

5. Seleccione “TEST”. 

 La alarma acústica se apaga. 
 

 

 

4.8 Consultar el registro 

 

 
 El “DISPLAY LOG” muestra que mensajes dispararon 

una alarma y que sustancia/s estuvieron implicadas. 

 

1. Abra el menú principal y seleccione “ALARM”. 

 

2. Seleccione “DISPLAY LOG”. 

 Una lista de las alarmas recientes se muestra 

en pantalla. 

  

BACK 

    ALARM 

AUTO DILUCIÓN 

WIRELESS ….. 

 

 

BACK 

ACOUSTIC 

TEST 

      DISPLAY LOG  

 

BACK 

  ALARM 

AUTO DILUCIÓN 

WIRELESS ….. 

 

 

BACK 

  ACOUSTIC 

VISUAL 

TEST 

DISPLAY LOG 

 

BACK 

  ALARM 

AUTO DILUCIÓN 

WIRELESS ….. 

 

 

BACK 

  ACOUSTIC 

  TEST 

DISPLAY LOG 
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5 Configuración el GDA 
 

 Para prevenir cambios accidentales de ciertas configuracio-

nes del GDA, que podrían conllevar falsos resultados, un ni-

vel experto (nivel de ADMIN) es introducido.  

Personal Las funciones descritas a continuación estan protegidas bajo 

contraseña y sólo pueden ser aplicadas por alguien con la 

autorización adecuada (generalmente el supervisor del dis-

positivo o un experto). 
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5.1.1 Vista general del menú del nivel de admin (vea versión del firmware) 

 

        

 BACK 
 

  BACK    BACK 

 ANALYTICS    IDENT    ACTIVATE 

  
   ZERO ADJUSTMENT    SUBSTANCE LIST 

         
     BACK    
 CALIBRATION    FLOW    

     FACTORY SETTINGS    

        

  
 

  BACK 
 

 BACK 

   

  DATA   STATUS 

       DELETE 

        

       BACK 
 LOG   ALARM   DISPLAY 

        DELETE 

         

       BACK 
  

 

  OPTIONS 
 

 INIT 

       FORMAT 

        

  
 

 BACK 
 

  BACK 
        SET 

  

 

 
KNG LIGHTING DU-

RATION 
  CONTINUOUS MODE 

       FACTORY SETTINGS 

        

     
 

 BACK 

 SETTINGS   WIRELESS (Opt.)   IP 

      

 FACTORY SETTINGS 

         

      
 

 BACK 
       

 

 ECC SENSOR 

      SERVICE LIFE   PID SENSOR 

         ZERO AIR FILTER 

          CIRCULATION FILTER 

           

       
 

 BACK 
      TIME   DISPLAY 

      CHANGE PSWD   SET 

        

      
 

 BACK 

   
 

  BACK 
 

  WARNING THRESHOLDS 
      OPTIONS    ALARM THRESHOLD 

          BACKGROUND 

         
 

 

Fig. 23: Vista general del menu del nivel de ADMIN 
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5.1.2 Primer inicio de session del nivel experto 

 

 El GDA se envía con la contraseña 001 por defecto.  Si 

quiere iniciar sesión por primera vez en el nivel de admin, 

proceda: 

 

 

 

1. Navegue a “ADMIN LEVEL”. 

 Introduzca la contraseña. 

El cursor se encuentra en el primer dígito. 

 

 

2. Use el botón izquierdo para navegar al siguiente dí-

gito “NEXT DIGIT” y confirme con el botón derecho. 

 El cursor se encuentra en el segundo dígito. 

3. Use el botón izquierdo para navegar al siguiente dí-

gito “NEXT DIGIT” y confirme con el botón derecho.  

 El cursor se encuentra en el tercer dígito. 

 

4. Use el botón iquierdo para navegar a “+” y confirme 

con el botón derecho. 

 

5. Incremente el dígito pulsando el botón derecho. 

 El tercer dígito ahora es 1. 

6. Use el botón izquierdo para navegar a “CONFIRM” y 

confirme su selección con el botón derecho. 

 El nivel de admin (ADMIN LEVEL) está activado. 

 

Cambio de contraseña 7. Para cambiar la contraseña, vea el capítulo “5.1.9 

Cambio de contraseña” 

 
 

  

 

BACK 000 

+ 

NEXT DIGIT 

 

BACK 001 

+ 

      CONFIRM 

 

BACK 000 

+ 

      NEXT DIGIT 

 

 

BACK 

ALARM 

AUTO DILUCIÓN 

WIRELESS  

      KNG MEASUREMENT 

   ADMIN LEVEL 
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5.1.2.1 Ejecutando un ajuste cero 

 

 

Para obtener resultados precisos, debe realizar un ajuste 

a cero antes de cada medición.  

El firmware del GDA ejecuta un ajuste cero automático 

antes de cada medición. 

Sin embargo, si quiere hacer un ajuste manual, debe estar 

identificado como ADMIN. Entonces, proceda: 

 

1. Pulse y mantenga el botón izquierdo para seleccionar 

el modo purga. 

 El GDA empiza a purgarse. 

 

2. Compruebe en la patalla que todos los canales están 

limpios. 

 No debe haber ninguna señal – o señales míni-

mas – visible. 

 

 

3. Abra el menu del nivel de admin “ADMIN LEVEL” y 

seleccione “ANALYTICS” seguido por “ZERO ADJUST-

MENT”. 

 

 

 Se ejecuta el ajuste a cero. 

  Cuando el juste a cero se complete, el GDA pasa 

automáticamente el modo de purga. 

 

 
 

  

BACK 

    ANALYTICS 

CALIBRATION 

LOG …. 

 

 

ZERO ADJUSTMENT 

IN 

PROGRESS 

AUTO DILUCIÓN 

WIRELESS 

KNG MEASUREMENT 

    ADMIN LEVEL 
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5.1.3 Estado del registro de datos 

 

 

1. Ir a ADMIN LEVEL seleccionar el menú LOG. 

 

2. Seleccionar DATA LOGGER. 

 

3. Seleccionar STATUS. 

 

 Se muestra el estado de la memoria del registra-

dor de datos 

 La pantalla que se muestra aquí indica el siguiente 

estado de la memoria, por ejemplo: 

● La targeta de memoria es 30.61% Completo. 

● Puede guardar las mediciones durante aproxi-

madamente otras 8 horas y 52 minutos. 

El registrador de datos está activado por defecto. 

 

4. Para salir de la pantalla, seleccioneCONTINUE. 

 

 

 

BACK 

ANALYTICS 

CALIBRATION 

   LOG …. 

 

 

BACK  

STATUS 

DELETE 

 

BACK  

DATA 

ALARM 

OPTIONS 

 

MEMORY STATUS: 

30.61 PCT FULL 

CA 8H 52 MIN LEFT 

  CONTINUE 
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5.1.3.1 Eliminar el registro de datos 

 

 

1. Abra el menú DATA LOGGER. 

2. Para borrar todo el contenido actual del registrador 

de datos por completo, seleccione DELETE. 

 

  Se muestra una pregunta de seguridad 

3. Para borrar el registrador de datos, confirme la con-

sulta con YES 

 Los datos quedan elimados 

 

 

 

5.1.3.2 Instalación o formateo del registro de datos 

 

 

1. Abra el menú LOG. 

2. Seleccione OPTIONS. 

 

3. – Si desea restablecer el registrador de datos, se-

leccione INIT y confirme la consulta de seguridad 

– Si desea reformatear la tarjeta de memoria, se-

leccione FORMAT y confirme la pregunta de se-

guridad.. 

 Si inicializa, se conserva el formato del contenedor 

.bin. Sin embargo, si formatea, se eliminarán todas 

las particiones. 

 

  

  

BACK  

STATUS 

   DELETE 

 

 

REALLY 

DELETE 

MEMORY? 

NO   YES 

 

 

BACK 

DATA 

ALARM 

   OPTIONS 

 

 

BACK 

  INIT 

FORMAT 
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5.1.4 Estado del registrador de alarmas 

5.1.4.1 Visualización de alarmas emitidas 

 

 Las alarmas emitidas se guardan y se pueden mostrar 

 

1. Abra el menú ADMIN LEVEL 

2. Abra el menú ALARM LOGGER  

 

3. Seleccione DISPLAY. 

 

 

  Las alarmas actuales se muestran de la siguiente 

manera 

: 

 

 

 

 

 

  

4. Si desea ver más alarmas emitidas, seleccione CONTI-

NUE, de lo contrario seleccione CANCEL. 

 

 

5.1.4.2 Eliminación del registro de alarmas 

 

 

1. Abra el menú ADMIN LEVEL 

2. Abra el menú ALARM LOGGER  

 

3. Seleccione DELETE. 

 

4. Confirme la pregunta de seguridad si realmente 

desea eliminar el registrador de alarmas. 

 El registro de alarmas queda eliminado 

  

 

 

BACK 

DATA 

    ALARM 

OPTIONS 

 

 

BACK 

   DISPLAY 

DELETE 

 

 

AROM B/T/C/CB 

29-05-08  C: 

12:49:52  AL: YES 

CONTINUE   CANCEL 

 

BACK 

DATA 

ALARM 

OPTIONS 

 

BACK 

DISPLAY 

DELETE 

 

REALLY 

DELETE 

MEMORY? 

NO    YES 

 

 

Identification 

Date Concentration 

Time Information about whether 

the alarm was output 
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5.1.5 Desactivación del modo Ident 

 

 

El modo Ident está activo por defecto. Esto significa que la 

pantalla muestra qué gas se ha detectado. Para apagar la 

pantalla de identificación (no recomendado), debe desac-

tivar el modo de identificación Desactivar el modo de 

identificación 

 

 

 

1. Seleccione ADMIN LEVEL. 

2. Seleccione ANALYTICS. 

3. Seleccione IDENT MODE. 

4. Seleccione ACTIVATE. 

 La barra negra junto a la palabra "ACTIVAR" 

desaparece. 

 El modo Ident está ahora activo. 

 Si desea reactivar el modo de identificación, 

seleccione ACTIVATE nuevamente. 

 

 Ponga la barra negra en la palabra “ACTIVATE”  

 El modo Ident está ahora activo nuevamente 

 

 

 

5.1.6 Consultar la lista de sustancias 

 

 

1. Abra el menú de nivel de admin en “ADMIN LEVEL. 

2. Seleccione “IDENT MODE”. 

 

3. Para mostar las sustancias guardadas en la librería, 

seleccione “SUBSTANCE LIST". 

 En pantalla se muestran las sustancias. 

 

 

 
 

BACK 

  IDENT 

ZERO ADJUSTMENT 

 

 

 

BACK  

ACTIVATE 

   SUBSTANCE LIST 

 

 

BACK 

   IDENT 

ZERO ADJUSTMENT 

 

 

 

BACK  

  ACTIVATE 

SUBSTANCE LIST 

 

BACK 

    ANALYTICS 

CALIBRATION 

LOG …. 
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5.1.7 Configuración del dispositivo de verifiación de contaminación (KNG) 

5.1.7.1 Determininación de la duración de la iluminación KNG  

 

 

 

1. Abrir el menú ADMIN LEVEL  

2. Seleccione SETTINGS y luego KNG LIGHTING  

DURATION.  

 

3. Para especificar la duración de la iluminación, 

Seleccione SET. 

 

 

4. Configure la duración de iluminación deseada en se-

gundos usando + o -. 

  

5.1.7.2 Configuración del modo continuo de duración de iluminación KNG 

 

 En modo continuo, la lámpara del desorbedor de 

superficie está continuamente activa hasta que 

vuelva a presionar el pulsador. 

1. Para activar este modo, navegue por el menú hasta 

el KNG LIGHTING DURATION y seleccione CONTI-

NUOUS MODE. 

  

5.1.7.3 Restablecimiento de la duración de la iluminación KNG a configuración inicial 

 

 

1. Para restablecer la configuración de duración de ilu-

minación KNG a la configuración de fábrica, nave-

gue hasta el menú KNG LIGHTING DURATION y se-

leccione FACTORY SETTINGS. 

 

2. Confirmar el restablecimiento a la configuración de 

fábrica 

 

 

 

 

BACK 

ANALYTICS 

CALIBRATION 

LOG  

  SETTINGS  

BACK 

  SET 

CONTINUOUS MODE 

FACTORY SETTINGS 

 

 

BACK 

+ 

- 

TIME:  4 

 

BACK 

SET 

 CONTINUOUS MODE 

FACTORY SETTINGS 

 

BACK 

SET 

CONTINUOUS MODE 

  FACTORY SETTINGS 

 

 

DO YOU REALLY WANT 

TO RESET 

TO FACTORY SETTINGS? 

NO   YES 

 

BACK 

   KNG LIGHTING DURATION 

WIRELESS 
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 La duración de la iluminación KNG se establece 

en tres segundos y se confirma el ajuste. 

 

5.1.8 Configuración de fecha y hora 

 

 

 

 

1. Abra el menú de nivel de admin en “ADMIN LEVEL”. 

2. Navegue a “SETTINGS” en el menú de opciones. 

3. Seleccione “TIME”. 

 

4. Para mostrar la fecha y hora actual, seleccione “DIS-

PLAY”. 

 La fecha y hora se muestran en pantalla. 

 

5. Seleccione “CONTINUE” para regresar al menu an-

terior. 

 6. Paracabiar la fecha y hora, seleccione SET. 

 

7. El parpadeo puede eliminarse en “SET”. Elija “CON-

TINUE” para salta la siguiente entrada. 

 

 

BACK 

ANALYTICS 

CALIBRATION 

LOG  

  SETTINGS 

 

 

 

BACK 

   DISPLAY 

SET 

 

 

DATE / TIME 

05.05.09 

18:40:51 

 CONTINUE 

 

SET TIME: 

05.05.09 

18:40:51 

CONTINUE   SET 

 

BACK 

KNG LIGHTING DURATION 

WIRELESS 

SERVICE LIFE 

   TIME 

 

 

 

FACTORY SETTINGS 

SUCCESSFULLY 

RESET 
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5.1.9 Cambio de contraseña 

 

 

1. Abra el menú de nivel de admin en “ADMIN LEVEL”. 

2. Seleccione “SETTINGS en elmenú. 

 

 

Seleccione CHANGE PSWD. 

 El curson se encuentra en el primer dígito. 

 

 

3. Utilice el botón izquierdo para navear a “+” y pulse 

el botón derecho hasta que el primer dígito sea el 

deseado.  

4. Use el botón izquierdo para navegar a “NEXT DI-

GIT”. 

5. Pulse el botón derecho. 

 El cursor se encuentra en el segundo dígito. 

6. Use el botón izquierdo para navegar a “+” y pulse el 

botón derecho hasta que el segundo dígito sea el 

deseado. 

7. Use el botón izquierdo para navegar a “NEXT DI-

GIT”. 

8. Pulse el botón derecho. 

 El cursor se encuentra en el tercer dígito. 

 

9. Use el botón izquierdo para navegar a “+” y pulse el 

botón derecho hasta que el tercer dígito sea el 

deseado. 

10. Use el botón izquierdo para navegar a “CONFIRM” y 

pulse el botón derecho para confirmar su SELEC-

CIÓN. 

 

 

 

5.1.10 Calibración del GDA 

 

 La calibración del GDA es llevada a cabo por AIRSENSE 

Analytics GmbH.  

➢ Envíe el GDA para una calibration.  

 

BACK 

ANALYTICS 

CALIBRATION 

LOG  

   SETTINGS 

 

 

BACK 001 

+ 

NEXT DIGIT 

 

 

BACK 001 

+ 

CONFIRM 

 

BACK 001 

+ 

   NEXT DIGIT 

 

 

BACK 

KNG LIGHTING DURATION 

WIRELESS 

SERVICE LIFE 

TIME 

  CHANGE PSWD 
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6 El software WinMusterGDA 
 

 El software WinMusterGDA se utiliza para el control di-

recto del GDA, así como la posterior revisión de medi-

cións.  Además, el software proporciona funcionalidad adi-

cional como mostrar la señal de los gases aspirado en un 

diagrama y el espectro positive y negativo. Los datos pue-

den ser exportados con locatización GPS en GoogleEarth. 

Algunos trabajos de mantenimiento, como el calenta-

miento del tubo de IMS, solo se pueden llevar a cabo con 

la ayuda del software 

  

6.1 Requirementos del sistema 

 

 ● Al menos 500 MB de espacio disponible en disco.   

● Puerto USB o RS-232 

● Resolución gráfica XGA (1024x768) 

● Monitor a color, min. SVGA (recomendado: SXGA) 

● CD-ROM 

● Windows Vista, 7, 8 or 10 

  

6.2 Instalación del software WinMusterGDA 

 
 Para instalar el software, necesita permisos de admi-

nistradr en el ordenador. 

1. Cierre todos los programas. 

2. Inserte el CD con el software. 

 

Fig. 24: Selección del idioma 

3. Seleccione el idioma para la instalación. 
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Fig. 25: Setup – WinMusterGDA 

A continuación se abre el asistente de instalación. 

4. Siga las instrucciones del asistente (vea el capítulo 

“6.3 Conexión del GDA al PC” on page 60. 

 

6.3 Conexión del GDA al PC 

 

Fig. 26: Adaptador USB 

1. El software requerido para utilizer el adaptador USB 

ya se encuentra instalado previamente. 

2. Conecte el GDA y el adaptador USB a un puerto USB. 

3. Conecte el GDA a una toma de corriente. 

 4. Encienda el GDA. 

5. Inicie el software del WinMusterGDA haciendo doble 

click en el icono   

Conexión manual del dispositivo:  

 

Fig. 27: Ventana settings 

1. Clicke en “Options” → “GDA parameters”. 

2. Conteste “No” a cualquier solicitud que pueda apare-

cer en este instante.  

3. Clicke en la pestaña “Connection” y seleccione el 

puerto COM al que el GDA se encuentra conectado. 

4.  Clicke “Apply”.  
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Búsqueda del dispositivo:  

 

Figure 28: Device search 

1. En el diálogo (Fig. 27), clicke en el botón “Devices”. 

2. Asegúrese que el botón “Com Ports” de la izquierda se 

encuentra active. Clicke “Find”. 

3. Si el Sistema encuentra el dispositivo, se muestra al fi-

nal de la lista. Clicke en el dispositivo para seleccio-

narlo y clicke en el botón de “Select”. 

4. La Ventana se cierra y el Puerto COM se copia auto-

máticamente en la opción. 

Después de la configuración ➢ Una vez la configuración está completada, puede car-

gar las librerías almacenada en el GDA.  

Para ello, proceda como se describe en el capítulo  

“6.7.1 Cargar una librería desde el GDA”. 
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6.4 Interfaz 

  

 

Fig. 29: Interfaz de usuario  

 

1 Menú  6 Intensidad 

2 Control  7 Diagrama de señales 

3 Barra de herramientas  8 Gráfico de barras 

4 Espectro positivo  9 Barra de estado 

5 Espectro negativo   

   
 

 
 Las ventanas individuales se pueden ajustar al ta-

manyo deseado y posicionalas a gusto del usuario. Si 

Cierra una ventana, puede ser abierta de nuevo me-

diante los iconos en la barra de herramientas. 

 



 

AIRSENSE Analytics GmbH 

Hagenower Strasse 73 · Germany 19061 Schwerin · Phone +49 (0) 385 3993280 · Fax +49 (0) 385 3993281 · Email: info@airsense.com · www.airsense.com 

63 

Control  

 

Símbolo Explicación 

 

Inicia la medición. 

 

Finaliza la medición. 

 

Enciende/apaga el ter-

modesorbedor. 

 

Configura el GDA a la di-

lución máxima. 

 

Deshace la dilución. 

 
Inicia el proceso selec-

cionado 
 

Si el GDA está conectado al ordenador, el dispositivo se 

controla mediante la ventana “Control”. Si esta Ventana no 

es visible, puede activarla en: “View → GDA control”. 

  

Comando especiales en el desplegable “Special com-

mands”  
 

Comando Explicación 

Zero point Inicia un ajuste cero (ajuste de la lí-

nea base). 

Sensor test Comprueba los sensors. 

Flow calibration Calibra el flujo. 

PID calibration El detector del fotoionización se 

puede calibrar aquí*. 

SC calibration El semiconductor se puede calibrar 

aquí*. 

ECC calibration La celda electroquímica (ECC) se 

puede calibrar aquí*. 

IMS tube bake off Apaga el calentamiento de los tubos 

del IMS. 

IMS tube bake on Enciende el calentamiento de los tu-

bos del IMS. 

Set time Sincroniza el reloj interno del GDA 

con el del ordenador. 

IMS mode Inicia la medición de IMS. 

Switch off device Apaga el GDA. 

Switch on device Enciende el GDA. 

  

 * PID, SC and EC calibration can only be performed by 

AIRSENSE Analytics GmbH. 
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Barra de herramientas 

La barra de herramientas propor-

ciona un acceso rápido a las funcio-

nes más frecuentes. 

Símbolo Explicación 

 

Inicia una medición. 

 

Carga un archivo de medición. 

 

Guarda la medición actual. 

 

Carga una librería existente. 

 

 

 

Guarda la librería en un archive. 

 

Imprime el diagrama actual. 

 

Inicia mnualmente la medición. 

 

 

 

Finaliza la medición. 

 

 

 

Abre el panel de control del GDA. 

 

 

 

Ajusta las ventanas automáticamente. 

 

 

 

Activa/desactiva el diagrama de datos. 

 

Activa/desactiva el diagrama de barras. 

 

Activa/desactiva la intensidad. 

 

Activa/desactiva el espectro positivo. 

 

Activa/desactiva el espectro negativo. 
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Espectro positivo y negativo  

 

El espectro es el resumen de las señales eléctricas del es-

pectrómetro de mobilidad iónica; que muestra la cantidad 

y velocidad de los iones positivos y negaticos. 

Esta ventana permita analizar y comparar la cantidad y ve-

locidad de las sustancias ionizadas en el gas de muestra. 

 

Intensidad  

 

La ventana de  “Intensity” con los valores actuales medi-

dos muestra un resumen de la información de la medi-

ción, incluyendo la identificación e información del gas 

medido. Esto ultimo se mostrará si la librería fue cargada 

y el gas se encuentra en la base de datos.  

 

Diagrama de datos  

 

Ilustra el progreso de la medició, reproduciendo la me-

dia a tiempo real.  
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Diagrama de barras  

 

El diagrama de barras muestra la reacción de cada uno 

de los sensores.  

Observando el gráfico, el usuario es capaz de evaluar la 

actividad de los sensors y poder tener una idea del tipo 

de compuesto medido.  

 

 

Barra de estado  

 Muestra el dispositivo conectado, el sistema actual de 

operación y la duración de la medición. 

  

6.5 Información de sustancia 

 

 

El WinMuster es capaz de mostrar información adicional 

sobre las sustancias detectadas. 

➢ Pase el cursor sobre el nombre de la sustancia en la 

ventana de “Intensity” y pulse (Ctrl + I) para mos-

trar información adicional. 

 También puede desactivar la información pulsando 

en “Do not display substance information”.  

 

 
 Para reactivar la información emergente, vaya a 

“View → All messages on”. 
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6.6 Confirguración del diagrama de datos 

 

 

Fig. 30: Display 

1. Navegue a “View → Settings”. 

 Se abre la ventana “Display”. 

–  En “Measurement diagram” puede mostrar u oc-

ultar  display of the individual sensors and other 

values 

–  En “Scale” puede ajustar la pantalla. 

– En “Lines” puede especificar el grueso de la línea 

y el número de lineas que se muestran el el dia-

grama. 

– En “Font” puede cambiar el tamaño de la letra. 

 

 
 

6.7 Gestión de las librerías 

 

 
 El software WinMusterGDA no incluye ninguna libre-

ría por defecto. Esta debe ser cargada del GDA o 

desde algún archivo. 

6.7.1 Cargar una librería desde el GDA 

 

 

Fig. 31: Cargando una librería desde 

el GDA 

1. Navegue a “File → Library → Load from GDA”. 

 La librería active actual (A, B o C) en el GDA es 

cargada al software. 

2. Guarde la librería en su ordenador. 

 WinMuster does not automatically load libraries 

when the program starts. This means that you have 

to upload the library again after restarting the soft-

ware. 

6.7.2 Reinicio de la librería 

 

 

Fig. 32: Reinicio de la librería 

1. Navegue a “File → Library → New”. 

 La librría actual es eliminada. 
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6.7.3 Cargar una librería desde un archivo 

 

 

Fig. 33: Cargando una librería desde 

un archivo 

1. Navegue a “File → Library → Load from file”. 

 Se abre la ventana “Load library”. 

2. Seleccione la librería que quiere cargar. 

3. Confirme su selección. 

 La librería cargada es utilizada en todas las me-

didas. 

 El WinMuster no carga automáticamente las libre-

rías cuando se inicia el programa.  

Debe cargar la librería de nuevo cuando reinicie el 

software. 

  

6.7.4 Guardar una librería en un archivo 

 

Fig. 34: Guardando una librería en 

un archivo 

1. Navegue a “File → Library → Save to file”. 

 Se abre la ventana “Save library”. 

2. Seleccione el directorio donde quiera guardar la li-

brería. 

3. Confirme su selección. 

 La librería es guardada en el directorio. 

  

  

6.7.5 Visualización de sustancias individuales en una biblioteca 

 

 1. Ir a “File → Library → Info”. 

 Se abre una ventana con una lista de todas las 

sustancias que están guardadas en la biblioteca 

actual. 
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6.8 Realizando mediciones desde el PC 

 

 
 Para impeder que el ordeador hiberne durante la 

medida, puede ir a “Options → GDA parameters” y 

seleccionar “Deactivate sleep mode during measure-

ment”. 

 

1. Cargue la librería desdeada desde el GDA al software.  

 Para asegurarse que tanto GDA como software po-

seen la misma información, cargue la misma librería 

en ambos.  

2. En la ventana “Control”, seleccione el método de me-

dición “Air”. 

3. En el menu desplegable, seleccione “Special com-

mands” y posteriormente el comando “Zero point”. 

4. Confirgure la dilución al 120%. 

 Una dilución del 120% implica que el GDA está en 

modo de purga; ya que, corresponde a una dilución 

del 100% y un 20% de exceso de purga. Una dilución 

del 100% significa que no se intruce muestra al dispo-

sitivo pero tampoco hay un exceso de aire introdu-

cido. La medición de la muestra empieza al 99% de 

dilución. A medida que disminuye el grado de dilu-

ción, augmenta la concentración de la muestra; hasta 

el 0%, donde hay un 100% de muestra. 

5. Clicke  [Start]. 

 Se inicia la medición. 

6. Para proteger el GDA de concentraciones excesivas, 

reduzca la dilución gradualmente (del 120% al 100%, 

99%, 98%, etc.). 

7. Espere hasta que el GDA muestre un resultado. 

8. Guarde los resultados de la medición en caso de que 

quiera consultarlos posteriormente.  

 Si no guarda los resultados y realiza otra medición, 

perderá esos resultados. La información de las medi-

ciones realizadas con el software no se guardan auto-

máticamente, ni en el GDA ni en el ordenador. 
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6.9 Gestión de datos 

6.9.1 Guardar los datos de medición 

 

 

Fig. 35: Guardado de los datos de 

medición 

1. Navegue a “File → Measurement → Save as…”. 

 Se abre la ventana “Save as”. 

2. Seleccione el drectorio donde quiera guardar la libre-

ría. 

3. Guarde el archivo con el nombre que desee. 

  

6.9.2 Cargar los datos de medición desde un archivo 

 

Fig. 36: Cargado de los datos de medi-

ción desde un archivo 

1. Navegue a “File → Measurement → Load file…”. 

 Se abre la ventana de “Load measurements”. 

2. Seleccione los datos que desea cargar. 

3. Confirme su selección. 

 Se muestran los datos de medición. 
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6.9.3 Cargar datos de medición desde el  GDA log 

 

Si tiene un lector de tarjetas SD en su PC, 

proceda de la siguiente manera: 

Las mediciones realizadas directamente a través 

del GDA (sin software de PC) se guardan en la tar-

jeta de memoria del GDA. Puede cargar estos datos 

de medición en el software 

 

Fig. 37: Clips de bloqueo en la trampilla de 

servicio 

1. Apague el GDA. 

2. Desconéctelo de la fuente de alimentación o 

retire la batería del compartimento de la bate-

ría. 

3. Suelte los clips de bloqueo de la trampilla de 

servicio (Fig.40) y retire la trampilla de servicio 

 

 

 

Fig. 38: Tarjeta de memoria detrás de la 

tapa de servicio 

4. Retire la tarjeta de memoria de la ranura para 

tarjetas de memoria. 

5. Inserte la tarjeta de memoria en la ranura 

para tarjetas de memoria correspondiente en 

su PC 

 Los datos de medición se almacenan en la tar-

jeta de memoria en el subdirectorio \Data. 

 

 

6. Vaya a “File → Measurement → Load GDA log 

→ Directory”.  

7. En el diálogo que se abre, seleccione el direc-

torio "Datos" en la tarjeta de memoria. 

 Se abre la ventana "Datos de registro" 

con los datos de medición disponibles. 

 

  


